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Performance Enhancement Functionality 
in MARS® version 2025.0 

 
Please Read -- Important information on single-thread vs multi-thread processing in MARS® 

 
 

1. Keyboard Accelerators 

2. Toggle Buttons 

3. Multi-Threading Capabilities 

a. Export 

b. QC processes 

c. Batch Process Tiles 

d. MARS® GeoCalc 

e. Add Spatial Index 

4. Double-Click on Tile in Tile Scheme 

5. Bookmarks 

a. Save 

b. Visit 

c. Delete 

6. Jump to: 

a. XY Location 

b. Tile 

c. Check Point 
 

7. Check Point Report 

8. Double-Click on Check Points in Report 

9. Display Options 

10. MARS® Task Manager 

11. Undo / Redo Buttons for Hand Editing Use 

12. Add Spatial Index 

13. Fast TIN 

14. ‘Reference Reclass (Closest Distance)’ Tool 
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15. Save to Local Option 

a. Export 

b. Batch Process Tiles 

c. QC Module 

16. Save / Load XML Settings 

a. Export 

b. QC Module 

c. GeoCalc 

d. Macro Filter/ Batch Process Tiles 

e. Breakline Properties Window 

17. ‘Auto Calculate Virtual Tile Size’ Grid Export Option 

18. Fast, Compressed JPEG 2000 Raster Exports 

a. Flightline Separation 

b. Hillshade 

c. LiDAR Spatial Distribution Verification Grid Tool 

d. LiDAR Raster JPEG 2000 export 

 

 

MARS Technical Support information 

 
To get the most out of the MARS®software’s multi-threading capabilities, please follow these general guidelines 
regarding the location of the data being processed.  Note that testing may be necessary to achieve the best results 
for each particular case.  

 

• Network disk server 
o High speed Input/Output (I/O) – always use the maximum number of threads available 
o Medium to lower speed I/O (or unknown) - single thread (1) is recommended 

• Internal drive 
o SSD (solid state drive) 

 High end level (NVMe) – always use the maximum number of threads 
 Consumer level – using multiple threads should perform better than single thread but 

experimenting on what maximum thread count to use for each process is recommended 
o HDD (hard disk [spinning] drive) 

 High RPM speed (e.g., 10,000 or 15,000) – lower multi-thread count is recommended and testing 
is encouraged 

 Lower RPM speed (e.g., 5400 or 7200) – single thread is recommended 
• External drive 

o USB 3.x 
 With a spinning drive (typical of most external drives) - single thread is recommended 
 With an SSD - using multiple threads should perform better than single thread but experimenting 

on what maximum thread count to use for each process is encouraged 
o USB 2.0 - single thread is strongly recommended 

 

Note - Using temporary local disk space in the scenario where the input or output data is located on a slower disk I/O 
location typically speeds up throughput if the local temp space drive is a high-speed disk such as an SSD. 
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1. Keyboard Accelerators: 
Most functions in MARS® support keyboard shortcuts (hot keys) which speed manipulation and use of the application. 

 

Keyboard Accelerator for the Help File: 

F1 Opens the Help Topics document for MARS® 

 
Common Keyboard Accelerators: 

Ctrl-N New MARS® project (.mpd file). 

Ctrl-O Open MARS® project (.mpd file). Does not open any other type of file. 

Ctrl-S Save MARS® project (.mpd file). 

Q Activate ‘Pan’ tool. 

+ Zoom in by a fixed amount (25%). Use ‘+’ on the regular keys (no ‘Shift’ needed) or number pad. 

- Zoom out by a fixed amount (25%). Use ‘-‘ on the regular keys or number pad. 

Esc   Exit out of any open dialog box. 

L   Toggle ‘Lock to view 100%’ tool on/off. 

T Toggle between viewing LiDAR points and viewing a TIN surface. 

X Toggle on/off LiDAR points.  

O Toggle on/off orthophotography (imagery). 

C Toggle on/off contour lines. 

S Toggle on/off shapefiles. 

M Toggle ‘Measure’ tool on/off. 

I Toggle ‘Inspect’ tool on/off. 

Ctrl-A Allow display of all LiDAR point classifications. 

Ctrl-K Allow display of only the model key-points (Class 2 with MKP bit flag set to ‘On’). 

Ctrl-G Allow display of only the ground point classification (2).  

Ctrl-E Color points or TIN by elevation. 

Ctrl-I Color points or TIN by intensity. 

Ctrl-C Color points or TIN by classification. 

Ctrl-R Color points or TIN by return. 

Ctrl-L Color points or TIN by collection scan. 

Ctrl-J Color points or TIN by RGB values. 

Ctrl-F   Color points or TIN by imagery RGB values (Color by Imagery Fusion). 

Ctrl-D Copy the X, Y (and Z, if available) coordinates values shown at the right side of the Status Bar to 
the Windows clipboard, based on the current cursor location. 

Ctrl-T Toggle Fast TIN on/off. 

Ctrl-Z Undo last vertex drawn or point placed when drawing 2D features from the ‘Vector Creation’ tab.  
Also undo last vertex drawn when creating a polygon with the 'Filter Digitized Polygon' tool. 

Z   Open the 'Elevation Repeat Colors Options' interface. 
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Keyboard Accelerators for Cross-Section/Profile View Manipulation (these options are only available when the 
cross-section/profiling window is open and selected) 
 

W Activate ‘Place Adjustable Cross-Section Line’ tool. 

D Set Depth of the cross-section/profile area. 

Up Arrow () Move the cross-section/profile area forward. 

Down Arrow () Move the cross-section/profile area backward. 

Right Arrow () Rotate the cross-section/profile area clockwise. 

Left Arrow () Rotate the cross-section/profile area counter-clockwise. 

Underscore ( _ ) In the Cross-Section/Profile window, toggle between ‘Cross-Section’ and ‘Profile by 
Collection Scan’ views. 

Ctrl-A Allow display of all LiDAR point classifications. 

Ctrl-K Allow display of only the model key-points (Class 2 with MKP bit flag set to ‘On’). 

Ctrl-G Allow display of only the ground point classification (2).  

Ctrl-E Color points or TIN by elevation. 

Ctrl-I Color points or TIN by intensity. 

Ctrl-C Color points or TIN by classification. 

Ctrl-R Color points or TIN by return. 

Ctrl-L  Color points or TIN by collection scan. 

R   Activate the 'Rotate Profile' window and allow the user to rotate the cross-section/profile area 
a specified number of degrees. 

 

Keyboard Accelerators for Point Editing in the LAS Map View Window 

0-9 Modify the currently selected points to the new classification indicated by the number key pressed. 
For example, the ‘5’ key modifies selected points to the point classification ‘High Vegetation’. 

G Activate the 'Edit Place Polygon' tool, which selects all points within the boundary of the user's 
manually defined polygon. 

Space 
Modify the currently selected points to the last target classification used. For example, if the last 
classification edited had a value of 6, then pressing the space bar will modify the currently selected 
points to the same target classification, 6. 

U Unselect all currently selected points. 

Ctrl-H Allow display of only classification (8). 

Ctrl-M Allow display of only the ground points classification (2) and the superseded classification (20). 

Ctrl-P Activate the small paintbrush tool for selecting points. 

P Activate the medium paintbrush tool for selecting points. 

Shift-P Activate the large paintbrush tool for selecting points. 

E Activate ‘Filter Region’ tool. 

N Re-use the last polygon created with the 'Filter Digitized Polygon' tool 

Esc  Leave the current editing mode. 

Ctrl-Z Undo the last edit step. 

Ctrl-Y Redo an edit step. 

Z    Open the 'Elevation Repeat Colors Options' interface. 
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Ctrl- Pan up by pre-selected percentage. 

Ctrl- Pan down by pre-selected percentage. 

Ctrl- Pan left by pre-selected percentage. 

Ctrl- Pan right by pre-selected percentage. 

 

Keyboard Accelerators for Point Editing in the Cross-Section/Profile Window 

0-9 Modify the currently selected points to the new classification indicated by the number key pressed. For 
example, the ‘5’ key modifies selected points to the point classification ‘High Vegetation’. 

Space  
Modify the currently selected points to the last target classification used. For example, if the last 
classification edited had a value of 6, then pressing the space bar will modify the currently selected points 
to the same target classification, 6. 

U  Unselect all the currently selected points. 

/ Activate the 'Edit Scrape Above' tool. 

? Activate the 'Edit Scrape Below' tool. 

S Activate the 'Line String Above' tool, which selects all points above a manually defined line string. 

Shift-S Activate the 'Line String Below' tool, which selects all points below a manually defined line string. 

Ctrl-P Activate the small paintbrush tool for selecting points. 

P Activate the medium paintbrush tool for selecting points. 

Shift-P Activate the large paintbrush tool for selecting points. 

E Activate ‘Filter Region’ tool. 

Esc Leave the current editing mode. 

Ctrl-Z Undo the last edit step. 

Ctrl-Y Redo an edit step. 

D   Open the 'Set Cut Depth' window to adjust the cut area depth of the cross-section/profile tool. 

Z Open the 'Elevation Repeat Colors Options' interface. 

R   Activate the 'Rotate Profile' window and allow the user to rotate the cross-section/profiling area a 
specified number of degrees. 

 

Keyboard Accelerators for Breakline Editing in the LAS Map View Window 

Esc Leave the current editing mode or dialog window. 

Shift-Mouse 
Click 

Holding down the shift key while compiling breaklines will cause the breakline to snap to the user-
designated point. The point to which the breakline will be snapped will be determined by the feature 
drop-down code list. Choose either: 'startendvertex', 'vertex', 'nearestpoint', or 'midpoint'. 

Ctrl-Mouse 
Click 

Ctrl-Click on a breakline the first time will collect that breakline's Z-value, and Ctrl-Click a second time 
will transfer that collected Z-value to a new breakline point that is currently being compiled. 

A When pressed and released during breakline collection, begins the creation of an arc (splined curve) 
in the breakline. The next two left-clicks will be the center and endpoint of the arc, respectively. 

B Toggle on/off the auto-pan mode. 

V Toggle on/off auto-pan edge markers. 

Alt 
Holding the 'Alt' key down while in collection mode will allow the user to pan across the data when 
auto-pan is turned off. The cursor will temporarily turn from collection tool to pan tool while the 'Alt' key 
is pressed.  

Ctrl-B Toggle display of breaklines on/off. 
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Ctrl-M Allow display of only the ground points classification (2) and the superseded classification (20). 

Ctrl-T Toggle Fast TIN on/off. 

Ctrl-Z Undo last vertex drawn when placing a breakline. 

Shift-B Quick save of breaklines without confirmation (when path/name has previously been established). 

 
Keyboard Accelerators for Editing Point Classes 
 
To enter a number for any class (0-9, 10-99, or 100-255), go to the 'Options Tab’ and click the ‘Miscellaneous' button.  

In the upper-right corner of this window is the 'Editing Options' section.  Check the box labeled 'Enable two or three digit 
class keyboard input'.  If LiDAR data contains classes with 2 or 3 digits (e.g., Class 14 or Class 122), this option can be 

useful during editing. Simply enter the 2- or 3-digit class, choose 'Enter' on the keyboard, and any LiDAR points 

highlighted will be changed to that classification.  Single-digit class values can also be applied while the 'Enable two or 

three digit class keyboard input' option is checked by choosing 'Enter' on the keyboard after the single number is entered.  

The points will then be reclassified.  When the  'Enable two or three digit class keyboard input' option is unchecked, points 

selected cannot be reclassified to 2- or 3-digit classes because as soon as one number is entered (interpreted by MARS® 

as a 1-digit class) the points are automatically reclassified without hitting the 'Enter' key.  For example, the user can select 

LiDAR points needing to be reclassified and enter ‘15’ if that is the intended target class.  Without the 'Enable two or three 

digit class keyboard input' option checked, the points selected will be reclassified to Class 1 because this was the first 

number entered on the keyboard to reclassify data.  See the upper-right of the 'Miscellaneous Options’ window below. 
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2. Toggle Buttons: 
The toggle buttons found on the View Tab provide easy access for control of the display.  Not all toggle buttons available 

on the tab speed up the performance and functionality of MARS®, so some are not described here. 

 
The View Tab: 

    

 
 
 
 

 Color by Elevation: Displays LiDAR points rendered by elevation. 

 Color by Intensity: Displays LiDAR points rendered by intensity value. 

 Color by Classification: Displays LiDAR points rendered by classification. 

 Color by Return: Displays LiDAR points rendered by return value. 

 Color by Collection Scan: Displays LiDAR points rendered by collection scan. 

 Color by Ground Color: Displays user-defined ground class(es) by RGB values and all other points by 

classification. (Must have imagery loaded for this option to become available.) 

 Color by RGB: Temporarily fuses the color from an ortho image to the LiDAR points for display purposes.  

 Color by Imagery (Fusion): Drapes imagery over the LiDAR points. (Must have imagery loaded to be enabled) 

 Blend with Intensity: Blends Intensity values with any other method (e.g., Elevation, Classification, Return, etc.) 

Color by CIR: Uses the R(ed), G(reen), B(lue), and N(ear Infrared) values stored for each LiDAR point to render the 

point cloud or TIN as a 4-band pseudo-image.  This option is intended for use with Point Data Record Format 

(PDRF) 8 point clouds that can store NIR values. 

 Color by Hillshade: This tool colors an elevation float grid by hillshade on the fly. It is only available if one or more        

float grids have been loaded in MARS® and can be used in 3D in conjunction with a float grid (*.flt) file. 

 Color by Z Delta: This tool will color the points in the LiDAR data by the vertical difference in flight lines.  

 Color by User Data: Displays LiDAR points rendered by the User Data value. There is currently no standardized 

use for this field. 

 Bit Flag: This tool brings up the ‘Bit Flag Display Settings’ interface which allows display control of LAS v1.4 

points based on several bit flag settings – Synthetic, Model Key-point, Withheld, Overlap, Edge of Collection 

Scan, Scanner Channel, and Scan Direction.  

Points: Display LiDAR data as points. Also known as a ‘point cloud’ display. 

TIN: Display LiDAR data as a TINned surface. 
 

 Lock to view 1%: Limits the display of point density to 1% (or less) of the loaded points when toggled on. 

mk:@MSITStore:C:%5CMARS%5Cdocs%5CMARS_H%7E1.CHM::/color_by_cir.htm
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3. Multi-Threading Capabilities: 
 

 
 

The multi-threading control pictured above is found in the following tools and functions.  It speeds up processing by 

utilizing a user-specified amount of a computer’s processing power.  For best performance, there should be a minimum 

of eight (8) GB of RAM available (not just installed) per thread. 

 
 a. Export: 
The multi-threading option is available for most export types in MARS®.  The control will default to the maximum number 

of threads the computer has available for processing.  Leave as is, or enter a lower number of threads to be used.  If ‘1’ 

is entered in the text box, it is equivalent to single-threading the process. 
 

b. QC processes: 
The multi-threading option is found in most of the MARS® QC functions, including the Raster QC tool and all drop-downs 

of the QC Module.  The control will default to the maximum number of threads the computer has available for processing.  

Leave as is, or enter a lower number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-

threading the process. 
 

c. Batch Process Tiles: 
For this tool, the multi-threading control will default to a value of ‘1’ (single-threading).  Enter a larger number of threads 

to process multiple tiles in parallel.  Depending on the density of the LAS data and the tile size, some testing may be 

needed to find the optimal multi-thread value. 

  
d. MARS® GeoCalc: 

For this tool, the control will default to the maximum number of threads the computer has available for processing.  Leave 

as is, or enter a lower number of threads to be used.  If ‘1’ is entered in the text box, it is equivalent to single-threading 

the process. 
 

e. Add Spatial Index: 
For this tool, the multi-threading control will default to a value of ‘1’ (single-threading).  Enter a larger number of threads to 

process multiple LAS files in parallel.  Depending on the file size, some testing may be needed to find the optimal multi-

thread value.  Multi-threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as the 

intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-threading.  USB 3.0 or 

later can be used but may be limited in performance depending on the speed (spin rate) of the external drive. 

  
Several other tools and functions also contain the multi-threading option, including Convert, Populate Statistics 

on Tile Scheme, Collection Scan Polygon Generator, and others.  In all cases, this option can shorten processing times by 

using the computer’s resources more efficiently. 
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4. Double-Click on Tile in Tile Scheme: 
To use this shortcut - which will speed processes such as hand editing - a tile layout shapefile must be loaded into 

MARS®.  Once a tile shapefile is loaded, the user can zoom to the extents of a single tile by double-clicking inside that 

tile’s boundary, if the ‘Double-click to zoom to tile extent’ box is checked in the ‘Viewing’ section of Options  
Miscellaneous. 

 

 

5. Bookmarks: 
A bookmark can be used to mark a certain place in the data and makes revisiting that same place easier and faster.  By 

saving a bookmark, the user will be able to click on the bookmark name in the future and be taken to the place in the 

data that the bookmark was placed.  Bookmarks are convenient when editing to be able to pick up editing in a specific 

location, or to save a place where rework needs to be done.  The bookmark tools can be found on the Navigation Tab. 

 
 

a. Save: 
To create or save a bookmark for future reference, choose this option.  The user will be shown a Bookmark Creation GUI 

to name and save the bookmark. Bookmarks are saved with an MPD (MARS Project Document). 

 
 

b. Visit: 
To visit a saved bookmark, use this option.  A list of saved bookmarks will appear.  Choose the desired bookmark and 

click 'OK' to view the bookmark placement.  
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c. Delete: 
To delete a saved bookmark, use this option.  A list of all saved bookmarks will appear - choose the bookmark to be 

deleted by highlighting it and clicking 'Delete' at the bottom of the window. 

 
 
 

         
6. Jump to: 

MARS® provides three methods to quickly navigate to a specific area-of-interest, as described below: 

 

 



June 25, 2025 Page 11 

a. XY Location: 
The ‘Jump to XY’ button on the Navigation Tab allows the user to navigate to a specific X, Y coordinate.  

 
 

b. Tile: 
The ‘Jump to Tile’ button on the Navigation Tab allows the user to navigate to the extent of a specific tile by using a 

unique field value.  To use this tool, a tile shapefile (*.shp) must be loaded into MARS®. 

 

 
c. Check Point: 

The ‘Jump to Check Point’ button on the Navigation Tab allows the user to navigate to a specific check point location.  

To use this tool, a check points file (*.csv or *.shp) must be loaded into MARS®. 

 
 

 
7. Check Point Report: 

When running a Check Point Report, the best performance can be obtained by using a computer with a discrete (and 

preferably, high-end) graphics card, especially when loading hundreds of GB or more of LAS data.  Once the data is 

loaded, turn off the ‘LAS’ layer in the Table of Contents but leave all individual file entries in this layer checked on.  Next, 

load the check points file (*.csv or *.shp) and then proceed with running the report. 

 

 

8. Double-Click on Check Points in Report: 
To use this shortcut, which may speed processes in QA/QC, a check points file (*.csv or *.shp) must be loaded into 

MARS® along with the corresponding LiDAR data.  Once the required data is loaded, the user can zoom to specific check 

points by double-clicking on them in the check point report.  To run a check point report, make sure both the LiDAR data 
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and corresponding check points file are loaded into MARS®, then go to the QA/QC Tab and click the ‘Check Point 
Report’ button.  Choose the classes on which to run the check point report, the elevation calculation method, the vertical 

units of the loaded LiDAR data, and choose either the ‘Vertical Accuracy’ or ‘3D Accuracy’ option depending on the 

check points file loaded and the specific results needed.  Click ‘OK’ and the report interface will appear.  In the ‘Statistics 

per Check Point (in data units)’ section of the report, choose a check point and double-click on the check point ID; 

MARS® will zoom to that selected check point in the LAS Map View window. 

 
 
9. Display Options: 

The 'Display Options' interface (Options Tab, Display button) is meant for use with LiDAR data and the Color by 

Elevation tool (on the View Tab) and allows the user to choose custom display options which best fit their needs.  This 

GUI may be used to prevent color skewing, which may occur when a small quantity of point values do not match values 

which are popular among the majority of points being displayed and increase the performance capabilities inside 

MARS®.  The display options allow the user to apply histogram clipping and stretching, as well as standard deviation 

stretching so that the resulting display is the most correct.  There are three (3) separate methods available to the user.  If 

the user wishes to make any of the custom settings the new default settings, simply choose the 'Make Default' button 

and these custom settings will be saved and available to the user the next time the 'Display Options' window is opened, 

even in a new session of MARS®. 

1. Minimum/ Maximum: With this option, the user may specify a minimum and maximum color range stretch for a 

histogram. 

2. Standard Deviation: With this option, the user may specify a number of sigmas to include in the display for both the 

left- and right-hand sides of a standard bell curve for a standard deviation stretch.  

3. Histogram: With this option, the user may specify a percentage cut-off for both the left- and right-hand sides of a 

histogram clip. 

1.            2.     3. 
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10. MARS ® Task Manager: 
The MARS® Task Manager button is located on the ‘Tools Tab’.  
 

The task manager will allow the user to monitor and/or end multiple MARS® processes at once.  To end a process, 

highlight it and it will appear in the 'Process Name to End' text box.  Click on the 'End Process' button to end the chosen 

process.  Note, however, that the session (instance) of MARS® that is running the MARS® Task Manager cannot be 

ended this way.  The 'Refresh' button allows the user to refresh the 'MARS® Task Manager' without closing and re-

opening the tool – ending a process will cause an automatic refresh. 

 
 
 
 
11. Undo/Redo Buttons for Hand Editing Use: 

  These buttons (on the Edit/Filter Tab) allow the user to undo/redo manual edits made in the profiling window or 

the main window.  Having this capability in MARS® can dramatically increase the efficiency and accuracy of hand 

filtering data.  

 
 

12. Add Spatial Index: 
This tool creates a spatial index on one or more LAS files to enable MARS® to read and display the point data.  It can 

add spatial index information, remove it, or mark any existing spatial index records as superseded.  Either of the last 

two uses may be necessary for using the files in other software. 

 

NOTE:  For best stability and faster performance, LAS files that have been spatially indexed in an older version 

(v2017.2 or earlier) should be re-indexed using version 2018.0 or later of MARS®.  This can be done quickly in two 
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steps using the multi-threaded 'Add Spatial Index' tool - the 'Fast Remove Index' option followed by the 'Add 
Spatial Index' option.  See the paragraph immediately before the screen shot of the tool interface for more 
information.  Also note that issues may occur with LAS files if they are spatially indexed in a newer version of 

MARS® and then have their index records removed in an older version. 
 
 

There are two ways to use ‘Add Spatial Index’: 

 

1) Add LAS files to MARS® 

If LAS v1.4 data without the necessary spatial indexing is among the files selected to be loaded into 

MARS®, the user will be provided a list of those files and three options for handling them: 
 

  

 

a) Choosing 'Spatially Index LAS Files and Add Them to Project' will permanently prepare the data (by modifying the file 

header) for viewing.  This process may be multi-threaded by entering a number greater than 1 in the 'Number of threads 
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to use' text box before clicking the 'Spatially Index...' button.  Please note the explanatory text in the interface (see above) 

concerning multi-threading.  For best performance, there should be a minimum of five (5) GB of RAM available (not just 

installed) per thread.  Multi-threading the Spatial Indexing functions across a USB 2.0 connection is not recommended as 

the intensive file reads/writes (disk I/O) may cause hangs or slower overall performance than single-threading.  USB 3.0 

or later can be used but may be limited in performance depending on the access speed of the external drive. 

 

A second window will appear with options for File Source / Point Source ID numbering. 

 

 

Depending on the user's preference or requirements, the files can be sequentially renumbered (in the 

order listed in the original window) by choosing the 'Assign collection scan numbers to all files' radio 

button and entering a starting number, or they can be indexed with no changes to any collection scan 

numbering they already have by choosing the 'Retain existing collection scan numbering for all files' radio 

button.  The 'Retain' option is the default.  Please read the method descriptions and caution 
statement before proceeding.  
 

If using the 'Assign' option, please note that LAS version 1.4 can have collection scan numbers of 1 to 

65,535.  Keep this limit and the total number of files in mind when entering a starting number. 
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After the choice has been made, click 'OK' to start the indexing and a status bar window will pop up.  

During this time, all files will be tested for empty 'System Identifier' header fields, and if found, will have 

this field populated with 'OTHER' (see the LAS file specifications on the ASPRS LAS File Format 

website).  Files with values already in place will not have this field altered.  When complete, the files will 

be loaded.  

 

b) Choosing 'No Change to LAS Files and Add Them to Project' will temporarily prepare the data for the 

current session of MARS®.  When indexed in this manner, no changes are made to the file header and 

the data will need to be re-indexed (either permanently or temporarily) if it is later loaded into another 

MARS® session. 

 

c) Choosing 'Ignore (Will not Add Them into Project)' will cancel the loading of any files without spatial 

indexing, but will load any previously indexed ones that were part of the original selection. 

 

 
2) Using the ‘Add Spatial Index’ interface - This method will permanently modify the header of LAS files when 

spatial index information is added or removed. 

To bring up the interface, go to the Project/Data Preparation tab and click the ‘Add Spatial Index’ button.  

 Navigate to the files to be spatially indexed by clicking on the 'Add' button.  Files may be removed from 

the list by highlighting them and clicking on the 'Remove Selected' or 'Remove All' buttons. 

 Choose one of the Collection scan options: 

https://www.asprs.org/committee-general/laser-las-file-format-exchange-activities.html
https://www.asprs.org/committee-general/laser-las-file-format-exchange-activities.html
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• Incremental: Assigns sequential collection scan numbers to each LAS file in the list to be 

spatially indexed.  Using this option will overwrite any existing collection scan numbering in 

the LAS files.  Enter the desired starting number in the 'Starting collection scan number' text 

box, keeping in mind that LAS version 1.4 files are limited to collection scan numbers of 1 to 

65,535.  If multi-channel files are being processed, check the 'Group Multi-Channel LAS files 

(one number per group)' box to have the same collection scan number assigned to each file 

in the group.  The tool requires that files in a multi-channel group be named identically 
starting with the letter 'L' except for a unique digit denoting the channel number 
following the mandatory letter 'C' - for example, 'L1-1-140324_A-C1_r.las and 'L1-1-
140324_A-C2_r.las' - for this collection scan numbering method to work. 

• No Assign - Keep the collection scan number of every point: No changes are made to 

collection scan numbering that may exist in the LAS files.  This is the default. 

• Set all files to one collection scan number: Assigns only one collection scan number to all 

listed files.  This option will overwrite any existing collection scan numbering in the LAS files.  

Enter the desired number in the 'Starting collection scan number' text box, keeping in mind 

that LAS version 1.4 files are limited to collection scan numbers of 1 to 65,535. 

 WKT: This area shows any existing WKT-based coordinate reference system definition for the added 

files and allows the information to be edited.  Changes made here will be applied only when adding 

spatial indexing. 

 Multi-Threading: The 'Add Spatial Index' tool is capable of multi-threading the indexing process.  To 

multi-thread (which may shorten the processing time), enter the desired number of threads up to the 

maximum available for the computer.  For best performance, there should be a minimum of five (5) GB 

of RAM available (not just installed) per thread.  Multi-threading the Spatial Indexing functions across a 

USB 2.0 connection is not recommended as the intensive file reads/writes (disk I/O) may cause hangs 

or slower overall performance than single-threading.  USB 3.0 or later can be used but may be limited 

in performance depending on the speed (spin rate) of the external drive. 

 Class options: This option allow a second spatial index to be created based on all classes EXCEPT the 

one(s) listed in the 'Majority Classes' box.  Click the 'Select' button to choose the desired majority 

classes.  When one or more of the chosen classes are turned off using the 'View Classification' button, 

performance is increased during display-related operations such as pan and zoom.  In addition, a 

higher percentage of the available point cloud will be displayed for a given window extent.  If more than 

one class was chosen as a majority class during indexing, the performance boost will be highest when 

all majority classes are turned off. 

 VLR/EVLR options: The 'Remove all VLRs/EVLRs before spatial indexing' option (unchecked by 

default) can be used to completely remove all Variable Length and/or Extended Variable Length 

Records (not just indexing records) from the LAS files listed in the 'Files to spatial index' box during the 

'Add Spatial Index' process.  This function works only when adding indexing, not when using the 

'Remove Spatial Index' or 'Fast Remove Index' buttons. 
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 Note:  All files will be tested for empty 'System Identifier' header fields and, if found, will have this field 

populated with 'OTHER' (see the LAS file specifications on the ASPRS LAS File Format website).  Files 

with values already in place will not have this field altered. 

 Click 'Add Spatial Index' to index the data, or 'Remove Spatial Index' to delete any existing spatial index 

records.  Removal will make LAS file sizes a little smaller, but will cause the files to be unloadable in 

future MARS sessions unless they are re-indexed.  The 'Fast Remove Index' button will mark all 

indexing records as superseded (ignored) without actually deleting them.  As with complete removal, 

this makes the files unreadable in future MARS sessions unless they are re-indexed, but the re-

indexing process will be much faster.  Either of the removal options may be helpful in loading data into 

other lidar software.  Neither the 'Remove Spatial Index' function nor the 'Fast Remove Index' function 

will make any changes to collection scan numbering. 

 

 

 

 

 

https://www.asprs.org/committee-general/laser-las-file-format-exchange-activities.html
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13. Fast TIN: 
The ‘Fast TIN’ option inside MARS® should be used when hand filtering.  ‘Fast TIN’ will increase the speed at which 

TINned data can be rendered, especially during pan and zoom operations, and will make editing tasks go faster. 

 

IMPORTANT NOTE:  The ‘Fast TIN’ option should never be used when working with breaklines.  Breaklines are 

purposely ignored (to enhance rendering performance) when the ‘Fast TIN’ option is used and therefore will not have the 

desired visual effect on the ground surface. 

 

To use this option, go to the Options Tab, click the ‘Performance' button, and check the ‘Fast TIN’ box.  ‘Fast TIN’ can 

also be toggled on/off by using the shortcut key combination ‘Ctrl-T.’ 

  
 

 
 

14. ‘Reference Reclass – Closest Distance’ Tool (available with Production license only): 
This tool, found on the Tools Tab, allows the user to reclassify one set of LAS files (the 'Unclassified' input files) based 

on the classes found in another set of LAS files (the 'Classified' input files), by using various parameters found in the LAS 

files.  The tool determines which points will be reclassed based on the LAS points’ recorded time and position.  This is 

a special version of the ‘Reference Reclass’ Tool: (1) Time will be used to determine possible candidate points, and (2) 

X, Y, Z will be used to determine the closest candidate point.  This tool can process LAS data when the two inputs are in 

different time formats (for example: GPS Week Time and Adjusted GPS Time) because it also accounts for the position 

of an LAS point. 

Classified:  Browse to a folder which contains LAS files that have one or more classifications in each file.  

These files are usually in a tile scheme form, but other files can be used. 

Unclassified:  Browse to a folder which contains one or more files that have all points classified as a single 

default value.  These files are usually in collection scan form, but other files can be used. 

Output:  Browse to an output folder to store the results of this LAS classification transfer.  This selection choice 

is optional; if the user does not choose an Output folder, the ‘Unclassified’ input data is overwritten with 

the newly classified data based on this reference reclass function. 

Tile Option: Optionally, the data can be tiled upon completion based on a user-selected polygon shapefile tile 

scheme. 

Class Requirement: Checking this option will allow the tool to use every classification offered in the 'Classified' 

data to reclass points in the 'Unclassified' data.  When unchecked, individual classes can be chosen to 

participate. 
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Source Fields That Must Match Reference: This area of the interface gives the user the ability to use the 

values offered from the Classified to the Unclassified LAS files as a reference.  

Cache Unclassified LAS: Checking this option will cache all of the points specified in the 'Unclassified' input 

path to RAM per file.  This will make the tool process more quickly than it would working from two 

separate locations (specified by the 'Classified' and 'Unclassified' input paths) on a network.  

Virtual Tile Size: The user may specify a virtual tile size here.  The virtual tile size will identify the size of the 

area which the tool will process at any one time.  Computers with more RAM can process larger areas 

resulting in a shorter time to completion. 

 

 
 

 

15. Save to Local Option (Temporary Folder): 
a. Export: 

The ‘Save to Local Option’ can be found in the export interface for the following export types: Flightline Separation - JPEG 

2000, both ENVI Grid types, Esri ASCII Grid, Float Grid, IMG Grid, LAS, LAS Grid, TIFF Grid, Hillshade - JPEG 2000, 

LiDAR Spatial Distribution Verification GRID - JPEG 2000, LiDAR Raster JPEG 2000 Grid, LiDAR Point Density – Float 
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Grid, USGS Swath Separation Image, and both PLS-CADD Code types.  This tool speeds up MARS® by using temporary 

local disk space during export processing and is typically used when the ‘Output Directory’ is a network location.  There is 

no benefit to using it when the output is local.  To use this option during export of one of the file types listed above, check 

the ‘Use temporary local disk space to speed up processing’ check box and designate a temporary folder found on 

one of the computer’s local drives. The 'Temporary Folder' specified WILL NOT be the output folder used for the final 

export.  The specified ‘Temporary Folder’ is simply a directory with free space which can be used to speed up the 

processing of raster-based exports. 

 

Once the user has specified a temporary folder, MARS® will verify that there is enough space in the temporary folder to 

use in processing and the results will be shown in green below the ’Temporary Folder’ browse box. If the ‘Required 

Space’ amount is less than the ‘Free Space’ amount shown, the computer will use the local folder for processing.  NOTE:  
Most versions of Windows restrict an application's output of files to the root directory of drives.  It is strongly 
recommended that an actual folder be used for this option. 

  
 

b. Batch Process Tiles: 
The ‘Save to Local Option’ may also be used in conjunction with the Batch Process Tiles tool.  The option works the same 

way in this interface as it does in the export interface (see item a., above). 
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c. QC Module (available with Explorer QC or Production license): 
The ‘Save to Local Option’ works the same for this module as it does for the previous two examples - it speeds up 

performance by using temporary local disk space during processing.  It is available in all the drop-down tools within the QC 

Module, including the latest ‘USGS NGP LBS – 2022 rev. A’ compliance testing tool. 
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16. Save/Load XML Settings: 

 

a. Export: 
Another way to improve performance in MARS® is to use the ‘Save Settings to File’ and ‘Load Settings from File’ 
options found in the ‘Export’ interface.  The ability to save export settings will allow the user to make several separate 

exports with the same settings much more quickly than entering the setting specifications separately for every export and 

eliminates the possibility of typos.  To use this tool, simply open the Export or Export Area interface and enter the 

parameters for export.  Click on the ‘Save Settings to File’ button, navigate to the location in which the settings will be 

saved, name the XML file, and choose ‘Save’. Now that the settings have been saved, the user may exit MARS® and 

when another MARS® session is started, the ‘Load Settings from File’ option will allow the user to navigate to the folder 

which contains the previously saved XML file and load it into the MARS® export application. 
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b. QC Module (available with Explorer QC or Production license): 
The ‘Save Settings to File’ and ‘Load Settings from File’ options are available in all the drop-down tools of the ‘QC 

Module’.  When using a previous settings file with ‘Load Settings from File,’ the file is checked for compatibility with the 

drop-down tool being used.  Otherwise, these two buttons function in the same way as for ‘Export’ (above). 

 

c. GeoCalc: 
The ‘Save Settings to File’ and ‘Load Settings from File’ options are also found in the ‘GeoCalc’ interface.  They 

function in the same way as for ‘Export’ (above). 

 

 d. Batch Process Tiles: 
The user can create or edit multiple macro filters using the ‘Create/Edit Script’ tool. To use this tool, go to the Edit/Filter 

Tab and click the ‘Create/Edit Script’ button.  The ability to save the specifications inside this interface allows the user to 

perform a particular macro filter or auto filter multiple times without having to enter the settings for the filter into the 

interface each time.  The ‘Save as’ option, found inside the ‘Create/Edit Script’ interface, functions very similarly to the 

‘Save Settings to File’ tool inside the export dialog.  Simply enter parameters for the batch script by adding, editing, or 

deleting filters and/or extraction tools within the macro.  When all entries are complete, click the ‘Save as’ button. 

Navigate to the location in which the settings will be saved, name the XML file, and choose ‘Save’.  Now that the settings 

have been saved, the user may exit MARS® and when another MARS® session is started, the user may choose the 

‘Browse’ button located to the right of the ‘Existing Batch Script File’ browse box and navigate to the folder which 

contains the previously saved XML file and load it into the MARS® Create/Edit Script application.  Any XML batch script 

that has previously been created can be loaded into MARS® with the ‘Load Script’ option.  To use this option, go to the 

Edit/Filter Tab and click the ‘Load Script’ button.  Browse to the folder which contains the desired XML file, choose it, and 

click 'Open' to load it into MARS®.  Once a batch script is loaded using this tool, it can also be edited. Upon loading the 

batch script, it will become an option in the Filter Action drop-down box.  Use the drop-down arrow to choose the desired 

macro if more than one exists within the batch script. 

 

e. ‘Breakline Properties’ Window: 
This tool is for use with breaklines.  Any breaklines which can be loaded into MARS® (or are created in MARS®) can be 

edited to fit the user's needs.  With this interface, the user can change the color and description of any breakline type, 

determine which features will be displayed, insert new features, rename features, and even load an already existing XML 

template with custom features, colors, and codes.  In the Compilation Options section of the interface, the user can search 

for points to use in elevation calculations, delete certain breakline classifications, and change the distance between points 

in a segment of a breakline, among other options. 
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17. ‘Auto Calculate Virtual Tile Size’ Grid Export Option: 
Virtual tiles are used by MARS® to allow processing of manageable data sizes in RAM.  A computer with less RAM needs 

smaller virtual tile sizes to complete an export while a computer with more RAM can process faster by using larger virtual 

tile sizes.  An optional 'Auto Calculate Virtual Tile Size' checkbox is available on the ‘Grid’ tab of Export to optimize 

internal processing based on a combination of average point density, available RAM, and the number of threads to be 

used during the export.  
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18. Fast, Compressed JPEG 2000 Raster Exports: 
a. Flightline Separation: 

This tool functions similarly to the 'Color by Z Delta' tool and creates a JPEG 2000 as the output product.  Having a fast, 

compressed raster export type such as JPEG 2000 can increase display speed and productivity.  This export type is 

intended for use over an entire project area.  The *.jp2 that is generated is based on the relative height differences 

between LiDAR data in overlapping areas.  The overlap area differences are color coded, allowing the user to immediately 

detect relative vertical accuracy problems.  The non-overlapping areas will show Intensity gridded data for reference 

purposes only.  This tool is useful for rapidly assessing the consistency of the LiDAR dataset's height and is highly useful 

in boresighting.  Over hard surfaces (such as roads) the user can expect the vertical height within the same ‘cell’ to be the 

same regardless of the LiDAR collection scan from which the data originates.  Differences are an indicator of a potential 



June 25, 2025 Page 27 

mission anomaly (typically a GPS/IMU problem) or a post-processing data adjustment issue.  In areas such as forests or 

fields, where vegetation growth varies according to the time of year, understandable error may be seen.  Lastly, the 

overlaid collection scan separation coloration will have a transparency set to it so that the output raster will still have some 

feature definition visibility.  Multi-threading capability is enabled for this export type which can increase the performance.  

Ideally, there should be a minimum of five (5) GB of RAM available (not just installed) per thread for best performance. 
 

Example: The raster shown below was created by exporting to a JPEG 2000.  Collection scan overlap is represented by 

the colored sections of the raster.  The colors are rendered based on collection scan separation using the ‘Color Options’ 

button on the ‘Grid’ tab.  There is a cross scan included in this example which runs horizontally rather than vertically.  The 

areas with no overlap are rendered by intensity value (gray-scale) only.  
 

 
 
b. Hillshade: 

This tool allows the user to create a hillshade image or raster from gridded elevation float grids (*.flt).  It is important to 

understand that the output file created by this tool is a raster.  It is designed to display quickly, and will only work in 2D 

(orthographic) view, not in 3D.  An image file, such as the JPEG 2000 produced by this export type, is much faster to 

display when using the pan, zoom in, or zoom out features than a float grid file would be.  For a temporary hillshade 

rendered from a float grid(s), click on the ‘Color by Hillshade’  button.  However, display is much faster when the 

hillshade is exported as a JPEG 2000. 
 

Below is a sample of an exported ‘MARS_Sample_Data_Hillshade’ JPEG 2000 file.  Because the resulting file is a raster, 

panning and zooming is much quicker than when using float grids with the hillshade created ‘on the fly.’ 
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c. LiDAR Spatial Distribution Verification GRID Tool: 
This tool is used to create a grid with values representing the presence (value=1) or void (value=0) of a first (of any) return 

LiDAR point within any portion of a predefined grid cell size.  This tool creates a JPEG 2000 file as the final product. 

Having a fast, compressed raster export type such as a JPEG 2000 can increase display speed and productivity.  

The development criteria for this tool were based upon the USGS LiDAR Base Specification 2021 rev. A (June 2021 and 

subsequent revisions), as stated:  

 

‘The spatial distribution of geometrically usable points will be uniform and regular.  Collections will be planned 
and executed to produce an aggregate first return point data that approaches a uniform, regular lattice of points. 
The regularity of the point pattern and density throughout the dataset is important and will be assessed by using 
the following method:  

 

• Assess only nonwithheld, first return points of a single File Source ID.  

• Exclude acceptable data voids previously identified in this specification.  

• Generate a density raster from the data with a cell size equal to twice the design ANPS. 

• Populate the raster using a count of points within each cell. 

• Ensure that at least 90 percent of the cells in the grid contain at least one lidar point.  
 

The USGS–NGP may allow lower passing thresholds for this requirement in areas of substantial relief where 
maintaining a regular and uniform point distribution is impractical.’ 

 

Below is an example result of the ‘LiDAR Spatial Distribution Verification GRID’ tool.  The green areas represent cells with 

a value of ‘1’, meaning they have at least one LiDAR point within the cell.  The red areas represent cells with a value of ‘0’, 

meaning they DO NOT contain any LiDAR points. In the example below it is easy to see that there is a body of water or 

other data void running through this area, which is the cause of the red cells with a ‘0’ value.  If the user were to implement 

the 'Minimum Zero Count' option when running this tool, the areas of contiguous ‘0’ cells (the water body) would return a 

null value instead of a ‘0’ value.  

 
 

The 'LiDAR Spatial Distribution Verification GRID' tool will also output a results text file (*.txt) every time the tool is used. 

This file will be output to the same location as the JPEG 2000 (the location specified by the user in the output directory 

browse box).  The text file will be named beginning with the date, time, and 

‘…LiDAR_Spatial_Distribution_Verification_Results.txt’.  This allows each *.txt created to be unique.  For instance, the file 

seen in the screen shot below was produced on February 2, 2011, at 2:45 pm. 
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The text file will contain the following information: the number of cells with a ‘0’ value, the number of cells with a ‘1’ value, 

and the number of value = ‘1’ cells as a percentage of the total number of cells.  This last value will be the percentage of 

passing cells.  This percentage needs to be 90% or above to comply with the USGS specifications mentioned above.  The 

screen shot below shows an example of the information contained in the text file. 

 

 
 

d. LiDAR Raster JPEG 2000 export: 
This tool is used to create a fast-exporting and fast-rendering JPEG 2000 raster from the loaded LiDAR data.  The raster 

cells can be colored by Class, Intensity, Elevation, or RGB values (if present). 
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MARS® Technical Support – General Information 

 

o Technical Support Hours: Weekdays from 9:00 AM – 5:30 PM (U.S. Mountain Time Zone) 
o Toll-free Telephone: (800) 544-1714 
o E-mail:    MARSsupport@merrick.com 
 

Technical Support Contacts 

 

 Mark A. Stucky - MARS® Technical Support Specialist (United States/Canada) 
    Office:  (303) 353-3933 
    E-mail: mark.stucky@merrick.com 

 Anca Dobrinescu - MARS® Technical Support Specialist (United States/Canada) 
  Office: (303) 226-9851    
  E-mail: anca.dobrinescu@merrick.com  

 

 

Social Media 

 

 

 

Please follow Merrick & Company for the latest MARS® product announcements, feature enhancements and 
user tips! 
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